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Introduction 

The typical examples of systems that require JESD204B multi-devices synchronization including 

phased-array radar, distributed antenna radar, medical imaging machines, cellular 

communications system and so on. This reference design demonstrates the implementation of 

two x8 Lanes JESD204B (Duplex) IP Cores synchronization in Arria 10 device through FMC 

loopback card. The main purpose is to emulate the interface between one converter card with 

two x8 Lanes JESD204B (Duplex) IP Cores. In this case, the transmitters of IP Cores are 

emulated as dual channel (16 lanes) Analog-to-Digital converter (ADC). The serial data from TX 

IP Cores are loopback to RX IP Cores through FMC loopback card. Besides that, this design 

allows internal serial loopback mode for debugging purpose. In this design, where LMF=841, 

S=1, K=32 and scrambler is on, the data rate of the transceiver lanes is 6.0 Gbps in bonding 

mode (TX).  

 

Theory of Operation 

Overview 

The design runs on Arria 10 GX FPGA Development Kit. Figure 1 shows a system level block 

diagram of JESD204B IP cores reference design with Nios II processor. 

 

 

 

Figure 1: Reference design block diagram 

Note: Link 0 and link 1 for JESD204B IP cores are also called instance 1 and instance 2 in Nios II project. Refer to Table 12 for 

more details about software parameters. 
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The reference design consists of the following key modules: 

 Top Level HDL 

 QSYS Top Level System 

a. JESD204B Subsystem 

i. Reset Sequencer 

ii. JESD204B IP Cores 

iii. Transceiver PHY Reset Controller 

iv. fPLL 

v. Avalon-MM Pipeline Bridge 

b. Nios Subsystem 

i. Nios II Processor 

ii. On-chip Memory 

iii. JTAG UART 

iv. Timer 

v. PIO 

vi. Avalon-MM Pipeline Bridge 

c. Core PLL and core PLL reconfiguration controller 

d. SPI Master  

 Transport layer 

a. Assembler (TX data path) 

b. Deassembler (RX data path) 

 Test Pattern Generator and Checker 

 Deterministic Latency Measurement Module 

 Frequency Checker 

 

Top Level HDL  

The Qsys top system, transport layer, test pattern generator and checker, deterministic latency 

measurement and frequency checker modules are instantiated in the top level HDL file called 

jesd204b_ed.sv. The top level HDL file located at the <project directory>/ directory includes 

the project parameters that define the configuration of the reference design. The parameters are 

described in the Table 1. 

 

Parameter Description 

LINK Number of JESD204B link. One link represents one JESD204B 
instance. A link composed of multiple lanes. Set to match the 
configuration in JESD204B IP core parameter editor. 

SUBSYSTEM Number of JESD204B subsystem in QSYS top level system. A 
JESD204B subsystem may contain multiple links that requires for 
multi-devices synchronization. 
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L Number of JESD204B lanes per converter device. Set to match the 
configuration in JESD204B IP core parameter editor. 

M Number of JESD204B converters per device. Set to match the 
configuration in JESD204B IP core parameter editor. 

F Number of JESD204B octets per frame. Set to match the 
configuration in JESD204B IP core parameter editor. 

N Number of JESD204B conversion bits per converter device. Set to 
match the configuration in JESD204B IP core parameter editor.  

N_PRIME Number of JESD204B transmitted bits per sample. Set to match the 
configuration in JESD204B IP core parameter editor. 

S Number of JESD204B transmitted samples per converter device per 
frame. Set to match the configuration in JESD204B IP core 
parameter editor. 

CS Number of JESD204B control bits per conversion sample. Set to 
match the configuration in JESD204B IP core parameter editor. 

F1_FRAMECLK_DIV Divider ratio for frame_clk when F=1. Refer to the JESD204B IP 
Core Design Example User Guide for more details. 

F2_FRAMECLK_DIV Divider ratio for frame_clk when F=2. Refer to the JESD204B IP 
Core Design Example User Guide for more details. 

POLYNOMIAL_LENGTH Defines the polynomial length for the PRBS pattern generator and 
checker. Refer to the JESD204B IP Core Design Example User 
Guide for more details. 

FEEDBACK_TAP Defines the feedback tap for the PRBS pattern generator and 
checker. Refer to the JESD204B IP Core Design Example User 
Guide for more details. 

 

Table 1: Top level HDL file parameters 

 

Clocking Scheme 

This reference design requires two clock sources coming from the Arria 10 GX FPGA 

development kit for proper operation. The reference design uses the default 100Mhz 

clock frequency from on-board oscillator. Table 2 summarizes the system clocking of 

this reference design. 

 

Signal Name Description Usage 

device_clk External 100Mhz clock from X3 
Si570 Programmable Oscillator.  

Input reference clock for core PLL (IO 
PLL), TX transceiver fPLL, RX transceiver 
CDR. 

link_clk Link and transport layer clock 
from core PLL (IO PLL). 

Clock source for each JESD204B IP Core 
link layer and transport layer link interface, 
deterministic latency measurement 
module. 
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frame_clk Transport and application layer 
clock from core PLL (IO PLL). 

Clock source for each transport layer, test 
pattern generator and checker 
 

mgmt_clk External 100Mhz clock from X3 
Si570 Programmable Oscillator.  

Management clock for nios II subsystem, 
transceiver reconfiguration interfaces, 
JESD204B IP cores Avalon-MM interfaces, 
altera PLL reconfig, SPI master, frequency 
checker. 

 

Table 2: System clock 

 

Qsys Top Level System 

In Qsys top level system file (jesd204b_ed_qsys.qsys), it instantiates the following components 

as indicated in Figure 2 below: 

 JESD204B subsystem 

 Nios II subsystem 

 Core PLL and PLL reconfiguration controller 

 SPI master 

 IRQ bridge 

The main data flows through the JESD204B subsystem. The frame data from pattern generator 
is forwarded to the assembler (TX transport layer). The assembler maps the frame data to non-
scrambled octet stream data to the transceiver lane. Each lane has 32-bits of parallel data in 
Avalon-ST protocol. For each L=8 IP core, the total parallel data bus width is 256 bits. The TX 
link layer (JESD204B IP core) receives this octet stream data from the assembler, performs 
scrambling (if enabled) and inserts alignment characters before forwarding the octet stream 
data to the physical layer. The physical layer (PHY) is part of the JESD204B IP core. The 8b/10 
encoded data from the physical layer is transmitted from the high speed serial link transmitter 
into the FMC loopback card. The FMC loopback card provides a passive pass through of the 
serial data from the transmitter to the receiver. At the physical layer of the receiver, the 8b/10b 
decoding is performed and the running disparity and not-in-table errors are monitored. The RX 
link layer performs lane/frame alignment, octet reconstruction and de-scrambles (if enabled) the 
data. The RX link layer outputs 8 lanes of 32-bit parallel data/lane in Avalon-ST protocol to the 
de-assembler (RX transport layer). The de-assembler maps the octet data stream to the frame 
data. Finally, the pattern checkers verify the data integrity of the frame data.       
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Figure 2: Qsys top level system block diagram 

Notes: 

1. System resets consists of: TX/RX JESD204B IP cores CSR resets, TX/RX link resets, TX/RX frame resets. 

2. The core PLL receives the device clock from an on-board Arria 10 GX FPGA development board as the 

input reference. The PLL generates two output clocks (using two output counters from a single VCO). The 

clock from output counter c0 is the link clock for each transport and link layer. The clock from output counter 

C1 is the frame clock for each transport layer, and pattern generator and checker. 

3. PLL Reconfiguration Controller is an optional component added in this design. It is required only if you want 

to update the output clock frequency, PLL bandwidth, and phase shifts in real time without reconfiguring the 

entire FPGA. 

4. SPI Master is an optional component added in this design. It is required if you want to use Nios II processor 

to write the configuration data to external converters via 4-wire SPI interconnect. 

 

The NIOS II processor in the NIOS II subsystem is the Avalon-MM master of the control path. 
The Avalon-MM slaves such as the JESD204B IP cores and peripherals are connected to the 
NIOS II processor through the Avalon-MM Pipeline Bridges. The core PLL generates the link 
clock and frame clock for the system. The mgmt_clk is directly sourced from external oscillator. 
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To view the top level Qsys system in Qsys, follow the steps below: 

1. Launch the Quartus Prime software. 

2. On the File menu, click Open. 

3. Browse and select jesd204b_ed_qsys.qsys file located in the project directory. 

4. Click Open to view the Qsys system. 

You can access the address mapping of the submodules in the top level Qsys project by 

clicking on the Address Map tab in the Qsys window. 

 

 

Figure 3: Top level system address map view in QSYS 

 

JESD204B Subsystem 

The JESD204B subsystem Qsys file (jesd204b_subsystem.qsys), instantiates the following 

components: 

 Two x8 lanes JESD204B IP cores configured in duplex, bonded mode (with TX and RX 

data paths) 

 Reset Sequencer 

 Transceiver PHY reset controller 

 fPLL 

 Avalon-MM pipeline bridge 

 

JESD204B IP Core 

The IP parameter settings for each JESD204B IP core is indicated in Table 3. The JESD204B 

IP base core and PHY layer connect to Nios II processor via the Avalon-MM interconnect. There 

are three separate Avalon-MM ports for the JESD204B IP core: 

 Base core TX data path – For dynamic reconfiguration of TX CSR parameters 

 Base core RX data path – For dynamic reconfiguration of RX CSR parameters 

 PHY layer – For dynamic reconfiguration of transceiver PHY CSR (including data rate 

reconfiguration) 
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Parameter Value Description 

Subclass 1 Subclass mode 

L 8 Number of lanes per converter device 

M 4 Number of converters per device 

F 1 Number of octets per frame 

S 1 Number of transmitted samples per converter per frame 

N 16 Number of conversion bits per converter 

N’ 16 Number of transmitted bits per sample 

K 32 Number of frames per multiframe 

CS 0 Number of control bits per conversion sample 

CF 0 Number of control words per frame clock period per link 

HD 1 High Density user data format 

SCR On Enable scrambler 

 

Table 3: JESD204B IP core parameter configuration 

 

Reset Sequencer 

The reset sequencer generates the system resets for the following modules in the system: 

 Core PLL reset – resets the core PLL 

 TX/RX Transceiver PHY reset – resets the TX/RX JESD204B IP cores PHY module 

 TX/RX JESD204B IP core CSR reset – resets the TX/RX JESD204B IP cores 

configuration status registers 

 TX/RX link reset - resets the TX/RX JESD204B IP cores base module, transport layer. 

 TX/RX frame reset – resets the TX/RX transport layer, pattern generator and checker 

modules. 

 

You can issue hardware reset or software reset to the reset sequencer. The reset input pin of 
the reset sequencer is connected to the PB0 push button on the Arria 10 FPGA development 
kit. Press PB0 push button to generate the hardware reset. The Nios II software generates the 
software reset to reset sequencer. The reset sequencer has a pre-defined reset sequence as 
shown in Figure 4. Figure 4 also shows the components that are affected by the reset outputs of 
the reset sequencer.  

The hardware reset follows this pre-defined sequence. The software reset has the flexibility of 
following this pre-defined reset sequence or overwriting the reset sequence.  
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Figure 4: Reset sequence 

 

Transceiver PHY Reset Controller  

The transceiver PHY reset controller receives the transceiver PHY reset output from the reset 

sequencer. It generates the proper analog and digital reset sequence for the two x8 lanes 

JESD204B IP cores PHY module.  

 

fPLL 

The fPLL is the Tx PLL. It generates the fast clock for the serial data in PMA and parallel clock 

for the parallel data in PMA and PCS. The reference clock input to the fPLL is the device_clk. 

 

Avalon-MM Bridge 

All the Avalon-MM slaves in the JESD204B subsystem are connected via Avalon-MM 

interconnect to a single Avalon-MM bridge. This bridge is the single interface for Avalon-MM 

communications into and out of system. 
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JESD204B Subsystem Address Map 

You can access the address map of slaves in the JESD204B subsystem by clicking on the 

Address Map tab in the QSYS window. The memory allocation address map is described as in 

Table 4 below. The design contains two JESD204B IP cores instances only per subsystem, so 

instance 2 and 3 in Table 4 are excluded. 

 

Avalon-MM Peripheral Address Map 

JESD204B IP cores transceiver 
reconfiguration interfaces 

0x0000_0000 - 0x0000_7fff (Instance 0) 
0x0001_0000 - 0x0001_7fff (Instance 1) 
0x0002_0000 - 0x0002_7fff (Instance 2)  
0x0003_0000 - 0x0003_7fff (Instance 3)  

fPLL 0x0000_8000 - 0x0000_8fff 

JESD204B IP cores CSR - TX 0x0000_c000 - 0x0000_c3ff (Instance 0) 
0x0000_c400 - 0x0000_c7ff (Instance 1) 
0x0000_c800 - 0x0000_cbff (Instance 2)  
0x0000_cc00 - 0x0000_cfff  (Instance 3)  

JESD204B IP cores CSR - RX 0x0000_d000 - 0x0000_d3ff (Instance 0) 
0x0000_d400 - 0x0000_d7ff (Instance 1) 
0x0000_d800 - 0x0000_dbff (Instance 2)  
0x0000_dc00 - 0x0000_dfff  (Instance 3)  

Reset Sequencer 0x0000_e000 - 0x0000_e0ff 

 

Table 4: JESD204B Subsystem Address Map 

 

Note: 

1. Due to the address space limit (0xc000-0xcfff and 0xd000-0xdfff) defined for JESD204B IP core TX/RX 

CSR, so you can only add up to 4 JESD204B IP cores instances for address ranges defined in this design. 

You may define the base address as indicated in Table 4 if your design contains four JESD204B IP cores 

instances per subsystem.  

2. You may need to define the new base address for the Avalon-MM peripherals to avoid conflict addressing 

occur if you have more than four JESD204B IP cores instances in your design.  

 

Nios II Subsystem 

The Nios II subsystem Qsys file (nios_subsystem.qsys), instantiates the following peripherals: 

 Nios II processor  

 On-chip memory – provide both instruction and data memory space 

 Timer – provides a general timer function for software 
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 JTAG UART – serves as the main communications gateway between user and Nios II 

processor via the terminal console in Eclipse tool. 

 Avalon-MM Pipeline Bridge – two Avalon-MM bridge modules; one to interface to the 

JESD204B subsystem and the other interface to the QSYS components (core PLL 

reconfiguration controller and SPI master module) 

 PIO – provides general input/output (I/O) access from the Nios II processor to the HDL 

components in the FPGA via two sets of 32-bit registers: 

- io_status (status registers input from the HDL components to Nios II) 

- io_control (control registers output from Nios II to the HDL components) 

 

The Table 5 and Table 6 describe the signal connectivity for the io_status and io_control 

registers. 

 

Bit Signal 

0 Core PLL locked 

1 TX transceiver ready (Link 0/Instance 0) 

2 RX transceiver ready (Link 0/Instance 0) 

3 Test pattern check data error (Link 0/Instance 0) 

4-31 TX transceiver ready, RX transceiver ready, and test pattern checker data error 
signals for subsequent JESD204B IP cores (Link 1-9/ Instance 1-9), if presents. 

 

Table 5: Signal connectivity for io_status registers 

 

Bit Signal 

0 RX serial loopback enable for two JESD204B IP cores in this design 

1 reserved 

2 reserved 

3 reserved 

4-30 reserved 

31 Sysref 

 

Table 6: Signal connectivity for io_control registers 

 

Nios II Subsystem Address Map 

You can access the address mapping of the peripherals in Nios II subsystem by clicking on the 

Address Map tab in the Qsys window. 
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Figure 5: Nios II Subsystem address map view in QSYS 

 

Nios II Processor 

This reference design uses Nios II processor as a control unit to control certain aspects of 

JESD204B system using C-based software control flow. The software C codes included as part 

of this reference design only perform basic JESD204B link initialization. You can modify the C 

codes based on your system specifications. 

 

 

Figure 6: Software main C code execution flow 
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The JESD204B link initialization performs the following tasks: 

 Set the pattern type or user mode for the pattern generator or checker. The default 

pattern type is set to PRBS. 

 Set the loopback mode. The default is external serial loopback mode. 

 Pulse SYSREF (required to meet Subclass 1 requirements) 

 Wait 10 seconds to allow for changes to take effect. 

 Report the link status 

 

The SYSREF signal acts as a common timing reference for multiple JESD204B Subclass 1 
devices in a JESD204B system to achieve deterministic latency. In general, SYSREF is a 
source synchronous to the device clock from single clock chip.  In most cases, the register in 
the IP core, which detects this SYSREF signal, is far away from the SYSREF pin. The long 
interconnect routing delay may result in timing violation. Because of there is no clock generator 
on the development kit that is capable of providing SYSREF to JESD204B IP cores, the PIO is 
used to generate the SYSREF pulse. The NIOS II processor instructs the PIO to generate 
SYSREF pulse, which is retimed by two stages pipeline registers before being sampled by each 
IP core. Refer to chapter 5 of JESD204B IP core user guide for constraining SYSREF signal if it 
is coming from FPGA input pin. 

 

 

Figure 7: Two stages pipeline registers for SYSREF signal 

 

The initialized ISR performs the following tasks: 

 Print and clear the RX/TX JESD204B error status registers. 

 Disable timer and JTAG UART interrupt generation. 

 

Core PLL 

The core PLL is an Arria 10 I/O PLL (altera_iopll) module that generates the link and frame 

clocks in the FPGA core fabric. 

For the frame clock, when F=1 and F=2, the resulting frame clock frequency can easily exceed 

the capability of the core. Thus, the top level RTL file (jesd204b_ed.sv) defines the frame clock 

division factor parameters, F1_FRAMECLK_DIV (for cases with F=1) and F2_FRAMECLK_DIV 

(for cases with F=2). This factor enables the transport layer and test pattern generator/checker 
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to operate at a divided factor of required frame clock rate by widening the transport layer 

Avalon-ST interface data width accordingly. For this reference design, the F1_FRAMECLK_DIV 

is set to 4 and F2_FRAMECLK_DIV is set to 2. For example, the actual frame clock and link 

clock required for a serial data rate of 6.0 Gbps and F=1 in this design is calculated as below: 

 

Clock Formula Description 

Link clock (from 
output C0) 

Serial data rate/40 The link clock clocks the link layer JESD204B 
IP Cores, link interface of transport layer, multi-
stage pipeline for SYSREF, deterministic 
latency measurement module. 

Frame clock 
(from output C1) 

Serial data rate/(10xF) The frame clock clocks the transport layer, test 
pattern generators and checkers 

 

Table 7: Core PLL outputs 

 

Frame clock = 6000/(10x1)/F1_FRAMECLK_DIV= 600/4= 150Mhz 

Link clock = 6000/40= 150Mhz 

 

PLL Reconfiguration Controller 

The PLL reconfiguration controller (altera_pll_reconfig) facilitates dynamic real-time 

reconfiguration of the core PLL. You can use this IP core to update the output clock frequency 

PLL bandwidth, and phase shifts in real time without reconfiguring the entire FPGA. The PLL 

reconfiguration controller connects to the NIOS II processor via Avalon-MM interconnects. The 

Nios II processor sends dynamic reconfiguration instructions to the controller during a dynamic 

data rate reconfiguration operation. However, this is an optional component because the design 

only showcases a static data rate operation. 

 

SPI Master 

The SPI master module (altera_avalon_spi) is a 4-wire, 24-bit width interfaces. This module 

uses the SPI protocol to facilitate the configuration of external converters (for example ADC, 

DAC, external clock chip) via a structured register space inside the converter device. The SPI 

master module is connecting to the Nios II processor via the Avalon-MM interconnects. This 

module is an optional component because the design only showcases external FMC loopback. 
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Transport Layer 

The transport layer provides the following services to the Application Layer (AL) and the Data 

Link Layer (DLL): 

 The assembler at the TX path 

- Maps the conversion samples from the AL (through the Avalon-ST interface) to a 

specific format of non-scrambled octets, before streaming them to the DLL. 

- Reports AL error to the DLL if it encounters a specific error condition on the 

Avalon-ST interface during TX data streaming. 

 The deassembler at the RX path 

- Maps the descrambled octets from the DLL to a specific conversion sample 

format before streaming them to the AL. 

- Reports AL error to the DLL if it encounters a specific error condition on the 

Avalon-ST interface during RX data streaming. 

 

Test Pattern Generator 

The test pattern generator has three patterns options; PRBS, alternate checkerboard, or RAMP 

wave. The test pattern is sent to the transport layer when test mode is selected. By default, the 

PRBS pattern test mode is selected. 

 

Test Pattern Checker 

The test pattern checker has three patterns options: PRBS, alternate checkerboard, or RAMP 

wave. The test pattern checker verifies the test pattern outputs from the transport layer when 

test mode is selected. 

 

Deterministic Latency Measurement Module 

The link latency of this design is measured from the TX core is ready to accept data (the rise of) 

until the data to the RX transport layer is valid. In this reference design, the RBD count varies 

from 0 to ((FxK/4)-1), which is 0 to 7. You may observe the RBD count=0 or 7 in this FMC 

external loopback setup. In this scenario, deterministic latency is not guaranteed because the 

RBD elastic buffer can be released either at the current LMFC boundary when RBD count=0 or 

one local multi-frame period later at the next LMFC boundary when RBD count=7. During 

multiple power cycles of the board, you may observe the link latency of 26 or 34 link clock 

cycles when RBD count is 0 or 7. Due to this, the lane de-skew error could happen during link 

initialization. To fix the deterministic latency issue, the csr_rbd_offset is programmed to 5 to 

force the release of RBD elastic buffer 5 LMFC counts before the next LMFC boundary. By 
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setting RBD offset value equal to 5, the counter consistently shows link latency of 29 link clock 

cycles (as indicated in Figure 14) from one power cycle to another power cycle.  

 

 

Figure 8: Early RBD release opportunity for latest arrival lane across two multi-frames 

 

Frequency Checker 

The frequency checker module is added in this design to measure the device clock, PHY clock 

generated from the transceiver parallel clock for the TX path and the recovered clock generated 

from the CDR for the RX path. This is useful for debugging and ensures that the frequency of 

measured clocks is as close as the desired clock. 

 

FPGA Pin Assignments 

The top level signals with its corresponding FPGA pin assignments on the Arria 10 GX FPGA 

development board are listed in the table below. 

 

Top Level Signal Name FPGA Pin Number I/O Standard Direction 

global_rst_n T12 1.8V Input 

device_clk AC8 LVDS Input 
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device_clk (n) AC7 LVDS Input 

mgmt_clk  AR36 LVDS Input 

mgmt_clk (n) AR37 LVDS Input 

tx_serial_data[0] BC7 High Speed Differential I/O Output 

tx_serial_data[0] (n) BC8 High Speed Differential I/O Output 

tx_serial_data[1] BD5 High Speed Differential I/O Output 

tx_serial_data[1] (n) BD6 High Speed Differential I/O Output 

tx_serial_data[2] BB5 High Speed Differential I/O Output 

tx_serial_data[2] (n) BB6 High Speed Differential I/O Output 

tx_serial_data[3] BC3 High Speed Differential I/O Output 

tx_serial_data[3] (n) BC4 High Speed Differential I/O Output 

tx_serial_data[4] BB1 High Speed Differential I/O Output 

tx_serial_data[4] (n) BB2 High Speed Differential I/O Output 

tx_serial_data[5] BA3 High Speed Differential I/O Output 

tx_serial_data[5] (n) BA4 High Speed Differential I/O Output 

tx_serial_data[6] AY1 High Speed Differential I/O Output 

tx_serial_data[6] (n) AY2 High Speed Differential I/O Output 

tx_serial_data[7] AW3 High Speed Differential I/O Output 

tx_serial_data[7] (n) AW4 High Speed Differential I/O Output 

tx_serial_data[8] AV1 High Speed Differential I/O Output 

tx_serial_data[8] (n) AV2 High Speed Differential I/O Output 

tx_serial_data[9] AU3 High Speed Differential I/O Output 

tx_serial_data[9] (n) AU4 High Speed Differential I/O Output 

tx_serial_data[10] AT1 High Speed Differential I/O Output 

tx_serial_data[10] (n) AT2 High Speed Differential I/O Output 

tx_serial_data[11] AR3 High Speed Differential I/O Output 

tx_serial_data[11] (n) AR4 High Speed Differential I/O Output 

tx_serial_data[12] AP1 High Speed Differential I/O Output 

tx_serial_data[12] (n) AP2 High Speed Differential I/O Output 

tx_serial_data[13] AM1 High Speed Differential I/O Output 

tx_serial_data[13] (n) AM2 High Speed Differential I/O Output 

tx_serial_data[14] AK1 High Speed Differential I/O Output 

tx_serial_data[14] (n) AK2 High Speed Differential I/O Output 

tx_serial_data[15] AH1 High Speed Differential I/O Output 

tx_serial_data[15] (n) AH2 High Speed Differential I/O Output 

rx_serial_data[0] AW7 High Speed Differential I/O Input 

rx_serial_data[0] (n) AW8 High Speed Differential I/O Input 

rx_serial_data[1] BA7 High Speed Differential I/O Input 

rx_serial_data[1] (n) BA8 High Speed Differential I/O Input 

rx_serial_data[2] AY5 High Speed Differential I/O Input 

rx_serial_data[2] (n) AY6 High Speed Differential I/O Input 

rx_serial_data[3] AV5 High Speed Differential I/O Input 

rx_serial_data[3] (n) AV6 High Speed Differential I/O Input 

rx_serial_data[4] AT5 High Speed Differential I/O Input 

rx_serial_data[4] (n) AT6 High Speed Differential I/O Input 

rx_serial_data[5] AP5 High Speed Differential I/O Input 

rx_serial_data[5] (n) AP6 High Speed Differential I/O Input 
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rx_serial_data[6] AN3 High Speed Differential I/O Input 

rx_serial_data[6] (n) AN4 High Speed Differential I/O Input 

rx_serial_data[7] AM5 High Speed Differential I/O Input 

rx_serial_data[7] (n) AM6 High Speed Differential I/O Input 

rx_serial_data[8] AL3 High Speed Differential I/O Input 

rx_serial_data[8] (n) AL4 High Speed Differential I/O Input 

rx_serial_data[9] AK5 High Speed Differential I/O Input 

rx_serial_data[9] (n) AK6 High Speed Differential I/O Input 

rx_serial_data[10] AJ3 High Speed Differential I/O Input 

rx_serial_data[10] (n) AJ4 High Speed Differential I/O Input 

rx_serial_data[11] AH5 High Speed Differential I/O Input 

rx_serial_data[11] (n) AH6 High Speed Differential I/O Input 

rx_serial_data[12] AG3 High Speed Differential I/O Input 

rx_serial_data[12] (n) AG4 High Speed Differential I/O Input 

rx_serial_data[13] AF5 High Speed Differential I/O Input 

rx_serial_data[13] (n) AF6 High Speed Differential I/O Input 

rx_serial_data[14] AE3 High Speed Differential I/O Input 

rx_serial_data[14] (n) AE4 High Speed Differential I/O Input 

rx_serial_data[15] AD5 High Speed Differential I/O Input 

rx_serial_data[15] (n) AD6 High Speed Differential I/O Input 

sync_n_in AR15 LVDS Input 

sync_n_in (n) AT15 LVDS Input 

sync_n_out AT17 LVDS Output 

sync_n_out (n) AU17 LVDS Output 

user_led_g[0] D18 1.8V Output 

user_led_g[1] C18 1.8V Output 

user_led_g[2] A19 1.8V Output 

user_led_g[3] J24 1.8V Output 

user_led_g[4] L25 1.8V Output 

user_led_g[5] K25 1.8V Output 

user_led_g[6] K26 1.8V Output 

user_led_g[7] L28 1.8V Output 

 

Table 8: Top Level Signals, corresponding FPGA pins, IO Standard and direction 

Note: In this design, the SYSREF signal is internally generated by PIO in the Nios II Subsystem. 

 

Quick Start Guide 

Hardware and Software Requirements 

The reference design requires the following hardware and software to run the test: 
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 Arria 10 GX FPGA Development Board (10AX115S2F45I1SG) 

 FMC Loopback Card 

 Quartus Prime version 16.1.2 Build 203 SJ Standard Edition 

 Nios II Embedded Design Suite (EDS) 

 

Hardware Setup 

Follow these steps to setup the hardware to run the reference design: 

1. Install the FMC Loopback Card module to the FMC port A (J1) on the Arria 10 FPGA 

development board.  

2. Use the default switching settings. For more details about default switching settings, 

please refer to Arria 10 FPGA development board user guide. 

3. Connect the micro-USB cable to the micro-USB connector (J3) on the development 

board. 

4. Connect the power adapter shipped with the development board to power supply jack 

(J13). 

5. Turn On the power for the Arria 10 FPGA development board. The hardware system is 

now ready for programming.  

 

 

 

 

Figure 9: Reference Design Hardware setup 

 

Running the Reference Design 

Follow these steps to configure FPGA: 

On-Board        

USB-Blaster (J3) 

II (J3) 

FMC Loopback 

Card  (port A) 

12 V DC Input 

Jack (J13) 



22 
 

1. To test the reference design targeted Arria 10 device, download the reference design file 

to your local project directory: 

 Two x8 lanes JESD204B (Duplex) IP Cores with internal/external FMC loopback 

reference design: A10_jesd204b_2x8L_nios_ref_design.par 

2. Launch the Quartus Prime Software. 

3. On the File menu, click New Project Wizard. 

4. On the New Project Wizard page, open Design Template Installation. Select the 

design template you want install. Click Next, then Finish.  

5. Before you begin the FPGA configuration, ensure the Quartus II Programmer and the 

USB-Blaster II driver are installed on the host computer, the board is powered and no 

other applications that use the JTAG chain are running. 

6. On the Tools menu, click Programmer. 

7. Click Auto Detect to display the devices in the JTAG chain and select a device. 

8. Right click and select Change File. Then, select the appropriate jesd204b_ed.sof file 

from the <project directory>/master_image and click Open. 

9. Turn on the Program/Configure option for the. sof file. 

10. Click Start to download the. sof file to the FPGA. Configuration is complete when the 

progress bar reaches 100%.  

 

Follow these steps to execute the software C code and initialize the JESD204B link: 

1. After device programming, navigate to the Tools menu and select Nios II Software 

Build Tools for Eclipse. 

2. In the Select a workspace dialog box, navigate to the software workspace, <project 

directory>/software and click OK. 

3. To import the software project into Eclipse, right click in the project explorer window and 

select Import. Under the general category select Existing Projects into Workspace 

and click Next. Select archive file and navigate to the zip file of interest. Click Finish 

and the project will be setup in your workspace. 

4. To download the executable code to the development board, right click on the 

jesd204b_nios2_ed in Project Explorer window and select Run As and then Nios II 

Hardware. Follow steps in page 31 to rebuild the nios ii project if it doesn’t work. 

The code performs the JESD204B link initialization sequence and exits after successful 

download the elf file. You can then view the code execution results on the Nios II Console 

tab.  The following tables list the expected values of the link status register for each 

JESD204B IP core. Note that you may refer to reconstruct design section if you want to 

rebuilt Quartus and nios ii project before running in hardware. 

 

Bit  Name Description Expected Binary Value 

[0] SYNC_N Value 0: Receiver is not in sync 
1: Link is in sync 

1 
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[2:1] Data Link Layer (DLL) 
State 

00: Code Group Synchronization 
(CGS) 
01: Initial Lane Alignment Sequences 
10: User Data Mode 
11: D21.5 test mode 

10 

 

Table 9: TX status 0 registers bits 

 

Bit  Name Description Expected Binary Value 

[0] SYNC_N Value 0: Receiver is not in sync 
1: Link is in sync 

1 

others - - Don’t Care 

 

Table 10: RX status 0 registers bits 

 

Viewing the Results 

Follow the followings steps to confirm the link for JESD204B instances 0 and 1 up successfully. 

1. In the Nios II console, you should observe it reports no pattern check error detected on 

JESD204B instances 0 and 1 (subsystem 0 in HDL) as indicated in Figure 10. You may 

refer to Table 9 and 10 above for the expected value of TX/RX status 0 registers for 

JESD204B instances 0 and 1.  

 

 

Figure 10: Pass/fail indication printed in Nios II console 

 

2. You should observe LEDs D3-D7 illuminate while LEDs D8-D10 off after successful 

bring up the links. 
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Figure 11: On board user LEDs 

 

The table below lists the status of LEDs for this design on the Arria 10 GX FPGA Development 

Kit and its function. 

 

LED Board Reference 
 

Signal Name Description 

D3 frame_rst_n Transport layer, test pattern generator 
and checker reset signal. The LED 
illuminates to indicate that the transport 
layer, test pattern generator and 
checker are out of reset. 

D4 link_rst_n JESD204B IP Cores link layer, transport 
layer link interfaces reset signal. The 
LED illuminates to indicate that the 
JESD204B IP Cores link layer, and 
transport layer link interfaces are out of 
reset. 

D5 sync_n SYNC_N from the JESD204B IP cores 
receiver. The LED illuminates to indicate 
it successful received K28.5 characters. 
 

D6 alldev_lane_aligned All lanes align signal for JESD204B IP 
cores instance 0 and 1. The LED 
illuminates to indicate all lanes are 
aligned. 

D7 rx_dev_sync_n_out Single AND SYNC~ signals from 
JESD204B IP cores instance 0 and 1 to 
the transmitter. The LED illuminates to 
indicate that the transmitter has 
received sufficient K28.5 characters. 

D8 jesd204_rx_int The link layer RX interrupt status signal 
from both JESD204B IP cores instance 
0 & 1. The LED illuminates to indicate a 
RX interrupt. 

D9 jesd204_tx_int The link layer TX interrupt status signal 
from both JESD204B IP cores instance 
0 & 1. The LED illuminates to indicate a 
TX interrupt. 
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D10 avst_patchk_data_error Single AND error status signal for 
PRBS, RAMP or ATL checkers for 
JESD204B IP cores instance 0 & 1. The 
LED illuminates to indicate a data error. 

 

Table 11: Status LEDs 

 

3. You may also observe the behavior of frame_rst_n, link_rst_n, sync_n, 

alldev_lane_aligned, rx_dev_sync_n, jesd204_rx_int, jesd204_tx_int and 

avst_pathchk_data_error signals through Signaltap II file to verify the links up 

successfully. Example of the expected Signaltap II outputs waveform are shown in 

Figure 12.  

 

 

Figure 12: Signaltap waveform (rx_link instance)       

 

In the output receiver transport layer, you are expected to see the PRBS, RAMP, ALT pattern 

based on the pattern source defined in main.h file. For example, you should see the pattern as 

indicated in Figure 13 if you set the SOURCEDEST_INIT in main.h file as RAMP pattern. 

 

 

Figure 13: Signaltap waveform (trpt instance) 
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Figure 14 shows the latency of link measured between transmitter and receiver in this design. 

The link latency is measured from rising edge of jesd204_tx_link_ready signal to rising edge of 

jesd204_rx_link_valid signal. 

 

 

Figure 14: Link latency measurement for RBD offset=5 

 

Software Parameters 

The software parameters defined in the main header file (main.h), which controls various 

behaviors of the C code. 

 

Parameter Default Value Description 

DEBUG_MODE 0 Set to 1 to print debug messages, else set to 0. 

PRINT_INTERRUPT_
MESSAGES 

1 Set to 1 to print JESD204B error interrupt messages, 
else set to 0. 

PATCHK_EN 1 Set to 1 when test pattern checker is included in the 
initial design data path configuration, else set to 0. 

DATAPATH 3 Set to indicate the JESD204B IP configurations: 
1- TX data path only 
2- RX data path only 
3- Duplex data path (TX and RX data path) 

MAX_LINKS 1 Set to 1 in this design to indicate a JESD204B 
subsystem that contains two JESD204B IP cores 
instances.  
 
Note: The maximum supported values of MAX_LINKS are 1 for 
two JESD204B IP instances in a subsystem. You may need to 
modify Nios II C code and Qsys base addresses space if: 

 More than 4 JESD204B IP instances in a JESD204B 
subsystem. 

 Multiple JESD204B subsystem 

MAX_INSTANCES 2 Set to indicate the number of instances in a 
JESD204B subsystem. Set to 2 in this design to 
indicate 2 JESD204B instances per subsystem. 
 
Note: The maximum supported value of MAX_INSTANCES is 2. 
You can add up to 4 JESD204B IP cores instances per 
subsystem without modifying the address space, but you need to 
modify the Nios II C code. 
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LOOPBACK_INIT 0 Initial value of the loopback. Set to 1 for internal 
serial loopback mode else set to 0. 

SOURCEDEST_INIT PRBS Initial value of source/destination. Set to indicate test 
pattern generator or checker type or user mode: 
USER – User mode (no test pattern generator or 
checker in data path). 
ALT – Test pattern generator or checker set in 
alternate checkerboard mode. 
RAMP – Test pattern generator or checker set in 
ramp wave mode. 
PRBS – Test pattern generator or checker set in 
parallel PRBS mode. 

 

Table 12: Software parameters 

 

Software Functions Description 

This section describes the functions used in main.c code and also the macros library that 

facilitates access to configuration and status registers (CSR) of the reference design. These 

functions and macros provide the building blocks for you to customize the software code based 

on your system specifications.  

 

Functions in main.c Source File 

Most of the function prototypes of the sub functions listed in Table 12 below can be found in the 

functions.h or main.c header file located in the software folder. 

 

Function Prototype Description 

int StringIsNumeric (char *) Tests whether the string is numeric. Returns 1 if 
true, 0 if false. 

void DelayCounter(alt_u32) Delay counter. Counts up to count ticks, each tick is 
roughly 1 second. 

Initialize(char *[ ] 
[MAX_OPTIONS_CHAR],int *) 

Perform the link initialization by executing Test, 
Sysref, and DelayCounter functions. Return1 if fail. 

int Status(char 
*[][MAX_OPTIONS_CHAR]) 

Executes report link status command according to 
the options. 

int Loopback (char 
*[][MAX_OPTIONS_CHAR], int *, int) 

Executes loopback command according to the 
options. Returns 0 if success, 1 if fail. 

int SourceDest (char 
*[][MAX_OPTIONS_CHAR], int *, int) 

Executes source or destination datapath selection 
command according to the options. Return 0 if 
success, 1 if fail. 
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int Test(char 
*[][MAX_OPTIONS_CHAR], int 
*)*held_resets) 

Executes test mode command according to the 
options. Test mode: 

 Set source/destination datapath selection to 
PRBS/RAMP/ALT test pattern 
generator/checker. 

 Set transceiver to internal/external serial 
loopback. 

Return 0 if success, 1 if fail. 

void Sysref (void) Pulse SYSREF one time (one shot) 

int ResetSeq (int, int *) Performs full hardware reset sequence through the 
software interface on the indicated link. Return 0 if 
success, 1 if fail. 

int ResetForce (int, int, int, int *) Forces reset assertion or deassertion on submodule 
resets indicated by reset_val for the indicated link. 
The function also decides whether assert and hold, 
deassert, or pulse the indicated resets. Return 0 if 
success, 1 if fail. 

int Reset_X_L_F_Release (int, int, int 
*) 

Deassert the transceiver, link, and frame resets. The 
function deasserts the TX transceiver reset first, wait 
until the TX transceiver ready signal asserts, then 
clear the TX error status register. Next, deasserts 
the TX link and TX frame resets. The function 
repeats the above actions for the RX side. Return 0 
if success, 1 if fail. 
 

void InitISR(void) Initialize the interrupt controllers for the following 
peripherals: 

 JESD204B IP core TX CSR 

 JESD204B IP core RX CSR 

 SPI Master 
The timer and JTAG UART interrupt controllers are 
disabled. Modify the function to enable it if needed 
in your design. 

void ProgCSR(void) Program the JESD204B IP core CSR (e.g program 
RBD offset) 

static void ISR_JESD_RX(void * 
context) 

JESD204B IP core RX ISR. Upon an interrupt event 
(IRQ asserted), the function reads the RX 
JESD204B CSR rx_err0 and rx_err1 registers and 
reports the error code. After that, the ISR clears all 
valid and active status registers in the rx_err0 and 
rx_err1 registers. 

static void ISR_JESD_TX(void * 
context) 

JESD204B IP core TX ISR. Upon an interrupt event 
(IRQ asserted), the function reads the TX 
JESD204B CSR tx_err registers and reports the 
error code. After that, the ISR clears all the valid and 
active status registers in the tx_err registers. 
 

 
static void ISR_SPI(void * context) 

The SPI master ISR. Upon an interrupt event (IRQ 
assert), clear the IRQ flag and return. 
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Table 13: Functions in main.c source file 

 

Custom Peripheral Access Macros in macros.c Source File 

A set of peripheral access macros are provided for you to access specific information in CSR of 

the following peripherals: 

 Reset sequencer 

 JESD204B TX 

 JESD204B RX 

 PIO control 

 PIO status 

 Transceiver PHY Reset Controller 

 fPLL 

 Core PLL Reconfiguration 

Most of the function prototypes of the macros listed in the table below can be found in the 

macros.h header file located in the software folder. For additional information about function 

prototype, you may refer to Table 43 of JESD204B IP Core Design Example user guide. 

 

Function Prototype Description 

int CALC_BASE_ADDRESS_LINK (int, int) Calculates and returns the base address based on 
the link provided. The link needs to be 0 because 
there is only one reset sequencer in the JESD204B 
subsystem. Hence, set the MAX_LINKS parameter 
in the main.h header file to 1. You are responsible 
to set the parameter correctly to reflect the system 
configuration. 

int CALC_BASE_ADDRESS_XCVR_NATIVE 
(int , int) 

Calculate and returns the base address of 
transceiver reconfiguration based on the instance 
number of JESD204B IP core. The number of 
transceiver per JESD204B subsystem in the design 
is defined by MAX_INSTANCES parameter in the 
main.h header file. This function is not used due to 
the design doesn’t perform data rate 
reconfiguration.  

int IORD_RESET_SEQUENCER_ 
STATUS_REG (int) 

Read reset sequencer status register at link and 
return the value. 

int IORD_RESET_SEQUENCER_ 
RESET_ACTIVE (int) 

Read reset sequencer status register at link and 
return 1 if the reset active signal is asserted, else 
return 0. 

void IOWR_RESET_SEQUENCER_ 
INIT_RESET_SEQ (int) 

Write reset sequencer at link to trigger full hardware 
reset sequence. 

void IOWR_RESET_SEQUENCER_ Write reset sequencer at link to force assert or 
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FORCE_RESET (int , int) deassert resets based on the val value. 

int IORD_JESD204_TX_STATUS0_REG (int, 
int) 

Read the JESD204B TX CSR tx_status0 register at 
link and instance and return the value. 

int IORD_JESD204_TX_SYNCN_ 
SYSREF_CTRL_REG (int, int) 

Read the JESD204B TX CSR syncn_sysref_ctrl 
register at link and instance and return the value. 

void IOWR_JESD204_TX_SYNCN_ 
SYSREF_CTRL_REG (int, int, int) 

Write val value into the JESD204B TX CSR 
syncn_sysref_ctrl register at link and instance. 

int IORD_JESD204_RX_STATUS0_ 
REG (int, int) 

Read JESD204B CSR rx_status0 register at link 
and instance and return value. 

int IORD_JESD204_RX_SYNCN_ 
SYSREF_CTRL_REG (int, int) 

Read JESD204B RX CSR syncn_sysref_ctrl 
register at link and instance and return value. 

void IOWR_JESD204_RX_SYNCN_ 
SYSREF_CTRL_REG (int, int, int) 

Write val value into JESD204B RX CSR 
syncn_sysref_ctrl register at link and instance. 

int IORD_PIO_CONTROL_REG (void) Read the PIO control register and return the value. 
 
 

void IOWR_PIO_CONTROL_REG (int) Write val value into the PIO control register. 

int IORD_PIO_STATUS_REG (void) Read the PIO status register and return the value. 

int IORD_JESD204_TX_TEST_MODE_ 
REG (int, int) 

Read the JESD204B TX CSR tx_test register at link 
and instance and return the value. 

int IORD_JESD204_RX_TEST_MODE_ 
REG (int, int) 

Read the JESD204B RX CSR rx_test register at link 
and instance and return the value. 

void IOWR_JESD204_TX_TEST_ 
MODE_REG (int, int, int) 

Write val value into the JESD204B TX CSR tx_test 
register at link and instance. 

void IOWR_JESD204_RX_TEST_ 
MODE_REG (int, int, int) 

Write val value into the JESD204B RX CSR rx_test 
register at link and instance. 

int IORD_JESD204_RX_ERR0_REG (int, int) Read the JESD204B RX CSR rx_err0 register at 
link and instance and return the value. 

void IOWR_JESD204_RX_ERR0_REG (int, 
int, int) 

Write val value the JESD204B rx_err0 register at 
link and instance. 

int IORD_JESD204_RX_ERR1_REG (int, int) Read the JESD204B RX CSR rx_err1 register at 
link and instance and return the value. 

void IOWR_JESD204_RX_ERR1_REG (int, 
int, int) 

Write val value the JESD204B rx_err1 register at 
link and instance. 

int IORD_JESD204_TX_ERR_REG (int, int) Read the JESD204B TX CSR tx_err register at link 
and instance and return the value. 

void IOWR_JESD204_TX_ERR_REG (int, 
int, int) 

Write val value into the JESD204B TX CSR tx_err 
register at link an instance. 
 

int IORD_JESD204_TX_ERR_EN_REG (int, 
int) 

Read the JESD204B TX CSR tx_err_enable 
register at link and instance and return the value. 

void IOWR_JESD204_TX_ERR_EN_ 
REG (int, int, int) 
 

Write val value into the JESD204B TX CSR 
tx_err_enable register at link and instance. 

 
int IORD_JESD204_RX_ERR_EN_REG (int, 
int) 

Read the JESD204B RX CSR rx_err_enable 
register at link and instance and return the value. 

void IOWR_JESD204_RX_ERR_EN_ 
REG (int, int, int) 

Write the JESD204B RX CSR rx_err_enable 
register at link and instance. 
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Table 14: Custom peripheral access macros in macros.c 

 

Reconstruct the Design and Run in Hardware 

Follow these steps to regenerate HDL files, compile, generate programming file, and configure 

FPGA: 

1. Download the reference design file to your local project directory: 

 Two x8 lanes JESD204B (Duplex) IP Cores with internal/external FMC loopback 

reference design: A10_jesd204b_2x8L_nios_ref_design.par 

2. Launch the Quartus Prime Software. 

3. On the File menu, click New Project Wizard. 

4. On the New Project Wizard page, open Design Template Installation. Select the 

design template you want install. Click Next, then Finish. 

5. Please note that the design downloaded from Design Store does not enable Signaltap II 

Logic Analyzer in Quartus project. To include the Signaltap II file into Quartus project, 

navigate to the Assignments menu and select Settings. Click on the Signaltap II 

Logic Analyzer under Category, and then check the Enable Signaltap II Logic 

Analyzer checkbox. Browse the stp1.stp file (located at /stp directory) and hit OK button. 

6. To compile the HDL with signaltap II file, navigate to the Processing menu and select 

Start Compilation. It will automatically generate the HDL files for system when you 

compile the project. 

7. Before you begin the FPGA configuration, ensure the Quartus II Programmer and the 

USB-Blaster II driver are installed on the host computer, the board is powered and no 

other applications that use the JTAG chain are running. 

8. On the Tools menu, click Programmer. 

9. Click Auto Detect to display the devices in the JTAG chain and select a device. 

10. Right click and select Change File. Then, select the appropriate jesd204b_ed.sof file 

from the <project directory>/output_files and click Open. 

11. Turn on the Program/Configure option for the. sof file. 

12. Click Start to download the. sof file to the FPGA. Configuration is complete when the 

progress bar reaches 100%.  

 

Follow these steps to rebuild Nios II software, re-execute the software C code and initialize the 

JESD204B link: 

1. After device programming, navigate to the Tools menu and select Nios II Software 

Build Tools for Eclipse. 

2. In the Select a workspace dialog box, navigate to the software workspace, <project 

directory>/software and click OK. 

3. Create a new Nios II application and board support package (BSP) template. On the File 

menu, navigate to New and click Nios II Application and BSP From Template. 
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4. In the Nios II Application and BSP From Template window, enter the following 

information: 

 SOPC Information File Name: <project directory>/jesd204b_ed_qsys.sopcinfo 

 Project name: jesd204b_nios2_ed  
(Note: you can choose any project name you like) 

 User default location: Checked 

 Templates: Blank Project 

5. Click Next. Verify that the default BSP name is jesd204b_nios2_ed_bsp, then click 

Finish. The Nios II application project (jesd204b_nios2_ed) and BSP 

(jesd204b_nios2_ed_bsp) appears in the Project Explorer window. 
Note: Whenever you regenerate the jesd204b_ed_qsys.qsys, you must regenerate the BSP files. In the 

Project Explorer window, right click the jesd204b_nios2_ed_bsp project, navigate to Nios II and click 

generate BSP.  This regenerates the BSP files based on your most current jesd204b_ed_qsys.sopcinfo. 

6. Import the design example source (*.c) and header (*.h) files into the application 

directory. In the Project Explorer window, right click on the jesd204b_nios2_ed project 

and click Import.  

7. In the Import window, select General > File System as the import source. Click Next. 

8. Browse to the <project directory>/software/source directory. Check the source box 

on the left panel. This selects all the source and header files in the source directory. 

Verify that the list of source and header files are as follows: 

 altera_jesd204_regs.h 

 functions.h 

 macros.h 

 main.h 

 macros.c 

 main.c 

Verify that the destination folder is jesd204b_nios2_ed. Click Finish. All the source and 

header files should be imported into the jesd204b_nios2_ed project directory. 

9. Right click the jesd204b_nios2_ed_bsp project, navigate to Nios II and click BSP 

Editor. Under the Drivers tab, check the enable_small_driver box of the 

altera_avalon_jtag_uart_driver group and click Generate. This setting allows the 

compilation to proceed without connecting the interrupt ports of JTAG UART module. 

After the BSP files have been generated, click Exit. 

10. Expand the jesd204b_nios2_ed application project in the Project Explorer window and 

verify that folder contains all the source and header files. 

11. To compile the C code, navigate to the Project menu and select Build all. The compiler 

now compiles the C code into executable code. 

12. To download the executable code to the development board, right click on the 

jesd204b_nios2_ed in Project Explorer window and select Run As and then Nios II 

Hardware. 

13. Follow the viewing results section to check the links up status. 
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